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Multi-voice ABC

While abc has done an excellent job of representing the music for which it was originally intended, that is to say the 
traditional dance music of the English-speaking world, it fares rather poorly when asked to represent music with 
several parallel melodic lines.  While you can stretch the abc definition to enable it to represent guitar music, as I did 
with 'St Louis Tickle'(in the abc primer file), it's not really adequate for the purpose, and it is quite impossible to 
represent keyboard music or orchestral music this way. 

Recently a new extension to abc has become available which permits a single abc tune to contain multiple voices.  
Each voice is identified by a numbered V: field at the beginning;  all the voices share the same header and are intended 
to be played simultaneously. 

Here is one of Bach's little fugues, showing how you can combine three voices independantly of one another.  To make 
this display properly in staff notation, you should turn on the "Align Voices" option in the View menu.  This pulls the 
notes into vertical alignment with one another depending on their timings, and causes all the bar lines to be drawn 
across all three staves.  This option slows down parsing quite a lot, and users with old 68K machines will probably 
want to keep it turned off while editing tunes. 

X:1
T:Fugue in Cm
C:J.S.Bach
V:1 program 1 19
V:2 program 1 19
V:3 bass program 1 19
M:4/4
Q:200
K:Cm
[V:1]  z8   |  z8     | zg/^f/g ce g/f/g=a   |
[V:2] z c/=B/c GA c/B/cd | G c/=B/c dF/G/A2G/F/ | E/c/=B/=A/G/F/ E/D/ Cedc |
[V:3]  z8     |  z8  |  z8  |
%
[V:1] dg/^f/g=a c/d/ e2d/c/| Be/d/e GA f/e/ f=A    |
[V:2] B=ABc ^FG=AF      | G2z/C/D/E/F/G/A3/ D/E/F/ |
[V:3]  z8  |  z8   |
%
[V:1] Bg/f/g =Bc d/e/ f2-     | f e/d/c/B/ A/G/ Fagf |
[V:2] G/=A/B3/ E/F/G/_A/ G/F/E/Dc/=B/ | c2z2zfed      |
[V:3]   z8            | zC,/=B,,/C,G,, A,,C,/B,,/C,D, |
%
[V:1] edef =BcdB                          | cg/^f/gd  e2z=e |
[V:2] zAGF   GF/E/FD                      | G2z=B c/z/c/B/cG |
[V:3] G,,C,/=B,,/C,D, F,,/G,,/ A,,2=G,,/F,,/ |\
 E,,/C,/=B,,/=A,,/G,,/F,,/E,,/D,,/ C,,/D,,/E,,/D,,/C,,/B,,,/A,,,/G,,,/ |
%
[V:1] f/z/f/=e/fc  d2zd | e/z/e/d/eB ce/d/ef  |
[V:2] F2z=A B/z/B/=A/BF  | G2zG  A/z/AGF      |
[V:3] F,,,/B,,/A,,/G,,/F,,/E,,/D,,/C,,/ B,,,/C,,/D,,/C,,/B,,,/A,,,/G,,,/F,,,/ |\
E,,,/A,,/G,,/F,,/E,,/^C,,/=C,,/B,,,/ A,,,C,,B,,A,, |
%
[V:1] Be/d/ef A/B/c2B/A/ | G/A/F/G/A/B/c/d/ e/d/c/d/e/f/g/=a/ |
[V:2] zA,B,C z  A,/G,/A,F,    | B,CB,A, B,G,F,E,    |
[V:3] G,,F,,G,,A,, D,,E,,F,,D,, | E,,A,,G,,F,, G,,E,,D,,C,, |
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%
[V:1] b/F/G/A/B/c/d/=e/ f/e/d/e/f/g/=a/=b/ | c'=b/=a/g/f/e/d/ cedc  |
[V:2] F,_D=CB, CA,G,F,       | G,G/^F/GC EG/=F/G=A       |
[V:3] D,,B,,A,,G,, A,,F,,E,,D,, | E,, z4C,B,,=A,,  |
%
[V:1] B=ABc        ^FG=AF        | G4   ||
[V:2] DG/^F/G=A        C/D/E2D/C/ | B,4  ||
[V:3] zE,D,C,, D,C,,/B,,/C,,D, | G,,4 ||

Some things to note.
In order to display correctly, the voice lines must be entered interleaved with one another i.e. they should appear in the 
abc in exactly the same order as they do in the music.  This is a limitation of the current version of BarFly - some 
other abc programs will let you enter multiple lines of music for each voice, i.e. 

[V:1]
<several lines of voice 1>
[V:2]
<several lines of voice 2>

abc files in this format should play OK in BarFly, but will not display properly. BarFly lets you put the music on the 
same line as the V: field provided that the V: field is enclosed in square brackets, as above.  Older versions of BarFly 
allowed this format without the square brackets, this is no longer supported, and if you have files in this format there is 
a command in the Utility menu which will convert a whole file of tunes in one operation (Convert old-style V: fields).

V: fields in the tune can only be written without the square brackets if they are placed on a separate line:

V:1
<a line of music>
V:2
<another line of music>

From version 1.7 on, BarFly permits the use of words instead of numbers as voice labels, so you can write [V:Treble] 
if you wish.

You can use the Format TuneÉ command in the Edit menu to rearrange multivoice abcs into the interleaved format 
which BarFly prefers, and to extract individual voices or merge them together.  (See the section on Format Tune here 
<file://:BarFly Commands##47545>)

The use of the V: field in abc is not at all standardised;  each program has its own way of specifying various options 
for the display and playing of the music, so as usual you are going to have to do a lot of editing on downloaded tunes 
to make them work. 

BarFly uses V: fields in the header of the tune to specify various global options; some of these apply to that voice 
throughout the tune, while some specify the starting conditions and can be changed as the tune progresses.  Note that 
V: fields in the header should not be enclosed in square brackets.

In the Bach fugue above, the header V: fields look like this:

V:1 program 1 19
V:2 program 1 19
V:3 bass program 1 19

"program 1 19" means the same as it does in a %%MIDI directive - use MIDI bank 1, general MIDI program 19, in 
this case meaning Church Organ.  This can be different for the different voices; you could change the last number to 
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read something different and make the three voices play on different instruments.  Alternatively, you could leave this 
out and let the program's instrument setting (in the Play menu) take care of it.

"bass" means display this voice on a staff with a bass clef.  The usual options apply here, you could also have treble 
(the default), alto or tenor clefs (but not, of course the Gregorian clefs!).  Clefs can change during the tune, so this only 
really specifies the starting condition for that voice.

Other options you can put here include:

merge           causes the voice to be drawn on the same staff as the preceding one.

up                      forces all note stems to be drawn upwards.

down            forces all note stems to be drawn downwards.

transpose n     shift the pitch when playing by n semitones (positive or negative).

tune n          shift the pitch by n/256 semitones (positive or negative).

mute            turn this voice off when playing (useful when you are working on an 
                        arrangement).

pan n           Set the stereo position of this voice.  n is in the range from -128
                        to +128, from full left to full right channel.

volume n        Set the volume for this voice in the range n=0 to 128.

bracketon       Bracket this voice with the following one(s).

bracketoff      Close the bracket.

longbaron       Extend all bar lines from this voice down through the following ones.

longbaroff      No extended bar lines from this voice on.

All of these are global settings and cannot be changed during a tune.
n is a whole number.
By default, brackets and long bars are on, and join all the staves together.  You may want to turn long bars off for 
voices which have lyrics written beneath them.

So, if you wanted to see the Bach fugue displayed as piano music, on two staves instead of three, you could change the 
V: fields in the header to read:

V:1 up program 1 1
V:2 down merge program 1 1
V:3 bass program 1 1

The order in which these keywords get entered is unimportant, and they are not case sensitive.  They do need to be 
present as "whole words" though, so you must use spaces, commas or some other non-alphabetical character in 
between them.

Merging multiple voices onto the same staff is not always successful.  For one thing, each voice only knows about its 
own accidentals, so you may have to put in multiple accidentals in some places to make things play properly.   While 
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the program will move rests up and down to avoid collisions with notes on the other voice, you may want to use 
invisible rests (x instead of z) in some places for clarity.

You can have separate vocals in multi-voice abc too.

Here's a simple example from the Shape-Note tradition of the southern USA:

X:2
T:Idumea
C:Charles Wesley
B:Original Sacred Harp.  Denson Rev. 1971
B:Sacred Harp Publishing Co. Inc. Bremen, Georgia 30110.
M:3/2
L:1/4
Q:150
V:Treble longbaroff
V:Bass bass
K:Am
[V:Treble] "^Treble"c2 | e4 d2 | c4 d2 | e4 e2 | d4 (ed) | e4 (dc) | A4 |]
w:And I am born to die. To lay this* bo-dy* down
[V:Alto] "^Alto"A2 | c4 (BA) | G4 G2 | A4 c2 | B4 (AB) | c4 (BG) | c4 |]
w:And I am* born to die. To lay this* bo-dy* down
[V:Tenor] "^Tenor"A2 | A4 (GA) | c4 (dc) | A4 e2 | g4 (ed) | c4 d2 | e4 |]
w:And I am* born to* die. To lay this* bo-dy down
[V:Bass] "^Bass"A,2 | A,4 D,2 | E,4 E,2 | A,,4 A,2 | G,4 (CB,) | A,4 G,2 | E,4 |]
w:And I am born to die. To lay this* bo-dy down
%
[V:Treble] |: A2 | c4 (cB) | A4 (cd) | e4 (BA) | G4 g2 | e4 (ed) | c4 [d2G2] |1 [e4A4] :|2 [e6A6] |]
w: And must my* tremb-ling* spir-it* fly In-to a* world un-known?
[V:Alto] |: c2 | G4 (AB) | c4 G2 | [c4E4] (Bc) | [d4G4] c2 | c4 (GF) | E4 G2 |1 E4 :|2 E6 |]
w: And must my* tremb-ling spir-it* fly In-to a* world un-known?
[V:Tenor] |: e2 | g4 (ed) | e4 (dc) | A4 (GE) | G4 G2 | A4 (GA) | c4 (dc) |1 A4 :|2 A6 |]
w: And must my* tremb-ling* spir-it* fly In-to a* world un-*known?
[V:Bass] |: A,2 | G,4 (A,B,) | A,4 E,2 | A,,4 C,2 | G,4 C,2 | A,,4 (C,D,) | E,4 E,2 |1 A,,4 :|2 A,,6 |]
w: And must my* tremb-ling spir-it fly In-to a* world un- known?
W:
W:
W: A land of deepest shade. Un-pierced by human thought;
W: The dreary regions of the dead, Where all things are forgot!
W:
W: Soon as from earth I go, What will become of me?
W: Eternal happiness of woe Must then my portion be.
W:
W: Waked by the trumpet sound, I from my grave shall rise;
W: And see the Judge with glory crowned, And see the flaming skies!

Here the only option I needed to set in the header V: fields was the longbaroff directive in voice 1 and the bass clef on 
voice 4, so that's all I put in.
(If you want to see this in its original notation, go to the View menu and set the Shape Notes submenu to Sacred 
Harp.)

Here's an example of using different instruments together.  In this case, what I'm aiming at is an Irish pub session, so 
the fiddle and flute parts are playing in unison.  The trouble with this is that Quicktime plays the parts so accurately, 
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exactly in tune and in phase with one another, that the voices merge together and sound like a single instrument.  In 
order to get around this I have slightly de-tuned them (real instruments are NEVER exactly in tune) and put in some 
small variations.  The result is quite realistic.  (You could, of course simulate the flow of Guinness across the bar by 
increasing the de-tuning as the night goes by :-)

You should set a suitable ornament macro (I like the Clare roll myself), and turn on Enable Macros and Use Stress 
Programming in the Player Preferences to play this properly.

X:3
T:Gan ainm
M:4/4
L:1/8
R:reel
V:1 program 1 73 tune 5         % flute
V:2 program 1 110 tune -5       % fiddle
V:3 program 1 25 transpose -12  % guitar
K:BDor
[V:1] F~B3 cdec|dfec BAFE|F~B3 ~a3g|afea ~f2 fe|
[V:2] F~B3 cdec|dfec BAFE|F~B3 caag|afea f2 fe|
[V:3] B,dBf DdAd | A,2[c2A2E2] F,BFc | B,dBf DdAd | [A,2E2A2c2][d2B2f2] F,FBd |
%
[V:1] fafe cfec|BABc defg|affe fecB|1 cfec B2 =GB :|2 cfec B2 Bc||
[V:2] fafe cfec|BABc defg|affe fecB|1 cfec B2 =GB :|2 cfec B2 Bc||
[V:3] B,dBf DdAd | B,cCc DcEc | B,2[d2B2f2] F,BFd |1 A,2[c2A2E2] F,2[F2B2d2] :|2 A,2[c2A2E2] F,2[F2B2d2] ||
%
[V:1] d~B3 aBgB|f~B3 cBAc|d~B3 caag|afea f2 fe|
[V:2] d~B3 aBgB|f~B3 cBAc|d~B3 caag|afea f2 fe|
[V:3] [B,4F4B4c4f4]z4 | [A,2E2A2c2e2]z2[D2A2d2f2]z2 |[B,4F4B4c4f4]z4 | [F,2C2F2A2c2f2]z2[B,2F2B2c2f2] Bd |
%
[V:1] fafe cfec|BABc defg|affe fecB|1 cfec B2 Bc :|2 cfec B2 =GB||
[V:2] fafe cfec|BABc defg|affe fecB|1 cfec B2 Bc :|2 cfec B2 =GB||
[V:3] B,dBf DdAd | B,cCc DcEc | B,2[d2B2f2] F,BFd |1 A,2[c2A2E2] F,2[F2B2d2] :|2 A,2[c2A2E2] F,2[F2B2d2] ||

Note for guitar players - this is one of those strange tunes which doesn't really have any chords.  You can play a Bm 
chord all through, or go to the opposite extreme and dress it up with jazz chord substitutions, 9ths and dim13s and it 
won't sound wrong.  My personal preference is for something in between with a bit of rhythmic clawhammer picking 
to liven things up, but your mileage may vary!

Finally, here's yer man Johann again, this time at the height of his powers in the stupendous Fugue in C#m from the 
first book of the Well-Tempered Clavier.  Five voices, in three subjects, coming and going all through with never a 
note out of place.  My son, who is a keyboard player, calls this a "Real Man's Fugue", and would give his eye teeth to 
be able to play it.  He says you would need hands the size of a bunch of bananas, for a start.  I haven't set an 
instrument for this, and merging the voices onto two staves is still far beyond the capabilities of the program.  
Actually, it's much easier to read on five staves anyway.  For greatest authenticity use a harpsichord, but piano sounds 
good too.

X:4
T:The Well-Tempered Clavier Vol 1 no 4 - Fugue
C:J.S. Bach
Q:350
M:4/4
V:3 bass
V:4 bass
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V:5 bass
K:C#m
[V:1] z8|z8|z8|z8|z8|z8|z8|z8|
[V:2] z8|z8|z8|z8|z8|z8|z8|z8|
[V:3] z8|z8|z8|z8|z8|z8|z4C4|^B,4E4|
[V:4] z8|z8|z8|G,8|^^F,4B,4|^A,8|G,4=A,4-|A,2G,F,G,2C2|
[V:5] C,8|^B,,4E,4|D,8|C,2D,2E,4-|E,2D,C,D,2G,2|C,2D,E,F,4-|F,2E,2D,2C,2|D,4C,4-|
%
[V:1] z8|z8|z8|z8|z8|z4c4|^B4e4|
[V:2] z8|z8|z8|z4G4|^E4A4|G4F4-|F4c4|
[V:3] D8|C4F4-|F2E2D2C2|C4B,4|C4F4-|F2E2D2C2|D4G4|
[V:4] F,2G,A,B,4-|B,2A,2G,2F,2|G,4F,2E,2|D,6=D,2|C,8-|C,8|z8|
[V:5] C,2B,,2A,,2G,,2|A,,4^A,,4|^B,,4C,4|G,,2A,,2B,,4-|B,,2A,,2G,,2F,,2|C,4A,,4-|A,,2G,,2F,,2E,,2|
%
[V:1] d8|c6d2|e2d2c4|B4c4|d4z4|z2e2d2c2|B2d2g4-|
[V:2] c4B4-|B4A4|G4A4-|A2G2F2E2|^A4G4-|G4^^F4|G4B,4|
[V:3] z2A2G2F2|^E2C2F4|E8-|E4G4|D4z4|z8|z8|
[V:4] z8|z8|z8|z4G,4|^^F,4B,4|^A,8|G,2=A,2G,2F,2|
[V:5] F,,4G,,4|A,,2G,,2A,,2B,,2|C,2B,,2C,2D,2|E,4C,4-|C,2B,,2^A,,2G,,2|C,4D,4|G,,4z4|
%
[V:1] g2f2g2a2|b8-|b2a2g2f2|gfedc4-|c4B4-|B2c2B2A2|
[V:2] C6C2|D2C2D2^E2|F4A4|G4zBAG|F2A2G2F2|^E4F4-|
[V:3] z8|z8|z4C4|^B,4E4|D8|C8-|
[V:4] ^E,4A,4|G,8|F,8-|F,2G,F,E,2F,G,|A,2F,2G,4|C,8-|
[V:5] z8|z8|z8|z8|z8|z8|
%
[V:1] G4^A2B2|c4B4-|B4^A4|B8-|B2c2d2e2-|e4d4|e2.d2.e2.f2|
[V:2] F2=E6-|E4D4|E8-|E2D2E2FG|F4B4-|B2c2B2A2|G4z4|
[V:3] C8|F,2G,2^A,2B,2|C8|z4E4|D4G4|F8|E4z4|
[V:4] C,8-|C,4F,4|E,2D,2E,2F,2|G,2F,2G,2A,2|B,8-|B,8-|B,4C4|
[V:5] z4B,,4|^A,,4D,4|C,8|B,,8-|B,,2G,2F,2E,2|B,4B,,4|E,4A,4|
%
[V:1] gfga gfeg |fefg fedf |edef edce |dcde dcBd |cBcd cB^Ac|
[V:2] z8|z8|z4G4|^^F4B4|^A8-|
[V:3] z8|z8|z8|z8|z8|
[V:4] ^B,4E4|D8|C8-|C2B,2^A,2G,2-|G,2^^F,^E,F,4|
[V:5] G,4C4-|C4^B,4|C4z4|z8|z8|
%
[V:1] B4- BcdB|c6e2|d6f2|e8-|e2d4c2-|
[V:2] ^A2D2G4-|G2FEF4-|F2EFG4-|G8-|G8|
[V:3] z8|z8|z8|z4[K:treble]c4|^B4e4|
[V:4] G,^A,G,^^F, G,A,B,G, |=A,B,A,G, ^A,B,CA, |B,CB,^A, ^B,CDB, |C8|z8|
[V:5] z8|z8|z8|z2C,D,.E,2.F,2|G,F,G,A, G,F,E,G,|
%
[V:1] c2^B^A.B2.d2|gfga gfeg|fefg fedf |^e4a4|g8-|
[V:2] d8-|d4c4-|c4^B2=B2-|BBc=d cBAc|BABc BAGB|
[V:3] z8|z8|z8|z2C2.F2.F2|F2^EDE4[K:bass]|
[V:4] z8|z8|z8|z8|z8|
[V:5] F,E,F,G, F,E,D,F, |E,D,E,F, E,A,G,A, |D,C,D,E, D,G,F,G, |C,4z4|z8|
%
[V:1] g2fe=d4|z2c2.f2.f2|f2e=de4-|e2=dcd4-|=d4c4|
[V:2] A4-AcBA |G4z4|z8|z4A4|G4c4|
[V:3] F2F,G,.A,2.B,2|CB,CD CB,A,C |B,A,B,C B,A,G,B, |A,G,A,B, A,B,C=D |E=DEF EDCE |
[V:4] z4F,4|^E,4A,4|G,8|F,8|z8|
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[V:5] z8|z8|z8|z8|z2E,2.A,2.A,2|
%
[V:1] f4e4-|e3f e=dce|=dcde dcBd |c8|^B4e4|
[V:2] B8-|B2E2A2A2|A2GFG4-|G2C^D.E2.F2|GFGA GFEG|
[V:3] =DCDE DCB,D |CB,C=D CB,A,C |B,8|A,G,F,E, D,C,^B,,C,|D,4z4|
[V:4] z8|z8|z8|z8|z2G,2.C2.C2|
[V:5] A,2G,F,G,4|A,4F,4|B,,4E,4|A,,8|G,,4z4|
%
[V:1] d8-|d2G2.c2.c2|c2BAB4-|B4A4|G4z4|
[V:2] FEFG FEDF|EDEF EDCE|DCDE =DCB,D|CB,C=D CE^DC |^B,4C4|
[V:3] z8|z8|z8|z2C,2.F,2.F,2|F,2E,D,E,4|
[V:4] C2^B,^A,B,4|C4A,4|F,4G,4|^E,4F,4|G,8|
[V:5] z8|z8|z8|z8|z2G,,2.C,2.C,2|
%
[V:1] d8|^^c4f4|^e4=e4|dcde dcBd|
[V:2] D2D2G^AB2-|B2^A2d2d2|d2c^Bc4-|c4B4|
[V:3] ^^F,4G,4|^E,2z2z4|z8|z2D,2.G,2.G,2|
[V:4] D,8|^E,2z2z4|z8|z8|
[V:5] C,2B,,^A,, B,,A,,G,,B,,|^A,,G,,A,,B,, A,,G,,F,,A,,|G,,F,,G,,^A,, G,,B,,A,,G,,|^^F,,4G,,4|
%
[V:1] cBcd cedc |^B4=B4|^A4=A4|G4z4|
[V:2] ^A4=A4-|A2D2.G2.G2|G2F^EF4-|F4E4|
[V:3] G,2F,E,F,4-|F,A,G,F, ^E,D,E,C,|F,^E,F,G, A,G,A,B,|[K:treble]C^B,CD EDEF|
[V:4] ^A,,4D,4|G,,4z4|z8|z8|
[V:5] z8|z8|z8|LC,,8|
%
[V:1] z8|z8|Lc8|L^B4Le4|
[V:2] D4C4|D8|z8|z2G2.c2.c2|
[V:3] GFGA GFEG |FEFG FEDF|EDEF EDCE|D4z4|
[V:4] z2G,,2.C,2.C,2|C,2^B,,^A,,B,,4|C,4z4|z8|
[V:5] L^B,,,4LE,,4|LD,,8|C,,2C,,D,,E,,2F,,2|G,,F,,G,,A,, G,,F,,E,,G,,|
%
[V:1] Ld8-|d4c4-|c4^B4|z2cd.e2.f2|
[V:2] c2^B^A BcdB|GFGA GFEA|FEFG FEDF|EGAB cd^Bc|
[V:3] z8|z8|z8|z8|
[V:4] z8|z8|z8|C,8|
[V:5] F,,E,,F,,G,, F,,E,,D,,F,,|E,,2E,2.A,2.A,2|A,2G,F,G,2G,,2|C,2B,,2A,,4|
%
[V:1] gfga gfeg |fefg fedf |edef e=dce|=dcde dcBd|
[V:2] d2z2z4|z8|z8|z2F2.B2.B2|
[V:3] z2G,2.C2.C2|C2^B,^A,B,4|C8|B,6F2|
[V:4] ^B,,4E,4|D,8|C,2E,2.A,2.A,2|A,2G,F,G,4-|
[V:5] z8|z8|z8|z8||
%
[V:1] cBc=d cBAc|BABc BAGB |A4z4|c8|
[V:2] B2AGA4|G8-|GGF^EF4|G4-GGFE|
[V:3] ^E4F4|B,4C4-|C4-CCB,A,|G,8|
[V:4] G,4F,4|G,8|A,4F,4-|F,F,E,D,E,2C,2|
[V:5] z2C,2.F,2.F,2|F,2^E,D,E,4|F,4z4|z8||
%
[V:1] ^B4e4|d8-|d2c2.g2.g2|g2fef4|
[V:2] DAGF EGc=B|AGAFG4-|G2c^Bc4-|c2^A2.d2.d2|
[V:3] z8|z8|z8|z8|
[V:4] G,8|F,4D,4|E,D,E,F, E,D,C,E, |D,C,D,E, D,C,^B,,D,|
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[V:5] z2G,,2.C,2.C,2|C,2^B,,^A,, B,,C,D,B,|E,,4z2A,,2|D,,4z2G,,2|
%
[V:1] e8|d4=g4|f4F4|^E4A4|
[V:2] d2cBc4|B4B4|^A4=d4|c8|
[V:3] z8|z2B,2.E2.E2|E2=DCB,2z2|z2C2.F2.F2|
[V:4] C,2E,2.A,2.A,2|A,2=G,F,E,4|z2F,2.B,2.B,2|B,2A,G, A,G,F,E,|
[V:5] C,,2z2z4|z8|z8|z4C,4|
%
[V:1] G2z2z4|z2^B2.f2.f2|f2ede2dc|d2^B2c4-|
[V:2] z2G2.c2.c2|c2^B^A Bcd2-|d2c^Bc4|F4G4-|
[V:3] F2EDE4|F6-FG|A2GFG2FE|D4E4-|
[V:4] D,4z2G,2|.D2.D2D2C^B,|C8|^B,4E4-|
[V:5] ^B,,4E,4|D,8|C,2E,2.A,2.A,2|A,2G,F, E,D,C,=B,,|
%
[V:1] c8|^B4=B4|^A4=A4|G8|
[V:2] G4F4-|F2^EF.G2.G2|G2C2.F2.F2|F2EDE4-|
[V:3] E4D2C2|D2^EF.G2.G2|z2FE.D2.C2|^B,4C4-|
[V:4] E2C,2.F,2.F,2|F,2^E,D,C,4-|C,4D,4-|D,2D,2.G,2.G,2|
[V:5] ^A,,4=A,,4-|A,,2G,,F,,^E,,4|F,,8|G,,8-|
%
[V:1] ^A4^B4|c8|^B4e4-|e4d2c2|
[V:2] E2FGA2G2-|G2E2.A2.A2|A2GFG2^A^B|c4^A4|
[V:3] C4D4|C2C2.F2.F2|F2EDE2FG|^A4D4-|
[V:4] G,2F,E,.F,2.F,2|F,2E,D,E,2D,C,|D,2G,,2.C,2.C,2|C,2B,,^A,,D,4-|
[V:5] G,,8-|G,,8-|G,,8|^^F,,8|
%
[V:1] ^B4c4-|c4^B4|c8-|c8-|c8-|Hc8||
[V:2] G4G4-|G8-|G4F4|^E4A4|G8-|HG8||
[V:3] D4E4|D6EF|^E2C6|C2C2.F2.F2|F4^E2D2|H^E8||
[V:4] D,E,F,2-F,E,D,C,|G,8|A,6G,A,|B,2A,2G,2F,2|C2B,A,G,2F,2|HG,8||
[V:5] G,,8-|G,,8|C,8-|C,8-|C,8-|HC,8||

If you would like some more Bach, my son and I have transcribed the entire set of Goldberg Variations, and you can 
get them from my web site:

http://www.barfly.dial.pipex.com/bftunes.html

SOME LIMITATIONS AND BUGS

Not all of BarFly's features work correctly with multi-voice abc.  In particular, the Play Selection and Play From 
Selection commands don't work properly (the parts play out of synch with one another). 

You will not be able to play Steve Allen's Beethoven transcription because it's simply too big;  BarFly cannot handle 
single tunes bigger than 32K, and the Beethoven was over 100K the last time I looked.

--------------------------------------------------------------------------------------------------------------------------------
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